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1 Generating Random Numbers

• Using Excel

– Type the following formula into a cell: =rand()

– This gives you a pseudorandom number between 0 and 1. If you want a
number between 0 and 10, multiply by 10: =10*rand()

– If you want an integer between 0 and 9, multiply by 10 then take the floor
(integer part) of the number: =floor(10*rand())

– If you want an integer between 0 and some arbitrary number (call it n),
you can use the “mod” function. CAUTION: This does not guarantee part
(2) of the definition of random numbers, so it is not recommended.

• Using the TI-30X IIS

– Press the PRB button. Choose RAND from the menu. (CAUTION: Do
not choose RANDI.)

– You will get a random number between 0 and 1. As above, you can read
off the digits of this number to get random digits between 0 and 9, or you
can multiply by 10 and take the integer part.

• Using the TI-83 or TI-84

– Press the MATH button. Navigate to the PRB menu. Select the rand()
function. As in the previous two methods, this generates a random number
between 0 and 1.

• Using a table

– Most statistics textbooks have appendices with tables listing randomly
generated digits between 0 and 9.
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2 Charts and Graphs in Excel

Note: The calculator models approved for this class do not have the capability to
make the charts described below, so all instructions are specific to Excel.

• Bar Charts (QUALITATIVE)

1. Start with a frequency table in Excel, including column headings.

2. Select all cells in the table, including column headings, but not including
row or column totals.

3. Under the “Insert” menu, in the “Charts” section, click the first option
under “Column.”

4. The bar chart will appear, but it will likely need some formatting changes
to be readable. You should click the “Layout” menu under the “Chart
Tools” heading and add axis titles and a chart title. Change the axis
scales if needed, and/or resize the chart to make it readable.

5. To show the frequencies (counts) on the chart, right click one of the bars
and click “Add Data Labels.”

• Pie Charts (QUALITATIVE and no overlap among categories so that total is
100%)

1. Start with a frequency table in Excel, including column headings.

2. Select all cells in the table, including column headings, but not including
row or column totals.

3. Under the “Insert” menu, in the “Charts” section, click the first option
under “Pie.”

4. The pie chart will appear, but it may need some formatting changes to be
readable. You should give the chart a title, make sure the legend/key is
showing, and/or resize the chart to make it readable.

5. To show the frequencies (counts) on the chart, right click one of the pie
pieces and click “Add Data Labels.” If you want it to show relative fre-
quencies (percentages) instead, first add the frequencies, then right click on
one of the count numbers and click “Format Data Labels.” In the popup
box, uncheck “Value” and check “Percentage.”

Document by A.Berardinelli



5

• Histograms (QUANTITATIVE)

1. The first time you do this, you’ll need to install the Data Analysis Add-In.
The instructions to do this are available on Microsoft’s website:
http://support.microsoft.com/kb/214269
Once you have the Add-In installed, a “Data Analysis” button will be
added to your “Data” menu.

2. Type or copy/paste the data values into a column.

3. In another column, type in the lower bounds for each of your classes. (For
example, if you want a bin for 0-9, 10-19, 20-29, etc., type 0, 10, 20, 30,
etc.)

4. Press the “Data Analysis” button under the “Data” menu. In the popup
box, select “Histogram” and then press the OK button.

5. In the “Input Range” box, enter the range of cells containing your data
values.

6. In the “Bin Range” box, enter the range of cells containing your lower
bounds of the classes for your histogram.

7. Make sure the “Chart Output” box at the bottom is checked.

8. Press the OK button.

9. In the chart that appears, right click one of the bars and select “Format
Data Series.” Under Series Options in the popup, enter 0% under “Gap
Width” and then press the “Close” button.

10. The histogram will likely need some formatting changes to be readable.
You should click the “Layout” menu under the “Chart Tools” heading and
add axis titles and a chart title. Change the axis scales if needed, and/or
resize the chart to make it readable.

11. To show the frequencies (counts) on the chart, right click one of the bars
and click “Add Data Labels.”
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3 Entering a Data Set

• Using Excel

1. Type (or copy/paste) the data values into a column.

• Using TI-30X IIS

1. Select the STAT menu (2nd + DATA). Go to the third option to clear
previous data if you have a list already stored.

2. After you’ve cleared the memory, in the STAT menu, select the 1-VAR
option if you are entering data for one quantitative variable. Select the 2-
VAR option if you are entering data for two related quantitative variables.

3. Select the DATA menu. Your calculator will prompt you for “X1=” and
enter your first data value. Hit the down arrow. For 1-VAR statistics,
your calculator will prompt you for the frequency of that value. (Leave
this as 1 if you are entering a list of values, change it to the frequency if
you are inputting data from a frequency table.) For 2-VAR statistics, your
calculator will prompt you for “Y1=” and you should enter the y value
corresponding to the x value you just entered.

4. Continue to arrow down until you’ve entered all values (and frequencies)
in your data set. (Note: The limit is 42 values.)

• Using TI-83 or TI-84

1. Select the STAT menu. Select the first option: “Edit...”

2. Arrow left or right to the list you want to populate. The calculator can
store up to 6 different lists simultaneously.

3. Enter your first data value. Press Enter. Enter the next value. Press
Enter. Continue in this fashion until you’ve entered all values.

4. You can use a second list to enter frequencies or a second variable, as
needed.
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4 Median

• Using Excel

1. Follow the instructions for Entering a Data Set.

2. In a blank cell, type the formula =median(RANGE) where RANGE is the
range of the cells containing your data values.

• TI-30X IIS does not compute the median.

• Using TI-83 or TI-84

1. Follow the instructions for Entering a Data Set.

2. Enter the STAT menu, then arrow over to the CALC menu. Select the
first option: 1-Var Stats.

3. Enter the list containing your data values (using the LIST button). If you
also have a frequency list, enter a comma (the button above the number
7) and then enter the list containing your frequency list (using the LIST
button). Hit Enter.

4. Arrow down to the “Med” value. This is the median of your data set.

5 Mean

• Using Excel

1. Follow the instructions for Entering a Data Set.

2. In a blank cell, type the formula =average(RANGE) where RANGE is the
range of the cells containing your data values.

3. Note: If your data is in a frequency table, use the methods we discussed
in class.

• Using TI-30X IIS

1. Follow the instructions for Entering a Data Set.

2. Press the STATVAR button.

3. Arrow over to x. This displays the mean of the data set you entered.
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• Using TI-83 or TI-84

1. Follow the instructions for Entering a Data Set.

2. Enter the STAT menu, then arrow over to the CALC menu. Select the
first option: 1-Var Stats.

3. Enter the list containing your data values (using the LIST button). If you
also have a frequency list, enter a comma (the button above the number
7) and then enter the list containing your frequency list (using the LIST
button). Hit Enter.

4. The first value x is the average of your data set.

6 Max, Min, Range

• Using Excel

1. Follow the instructions for Entering a Data Set.

2. For maximum value: In a blank cell, type the formula =max(RANGE)
where RANGE is the range of the cells containing your data values.

3. For minimum value: In a blank cell, type the formula =min(RANGE)
where RANGE is the range of the cells containing your data values.

4. For range: In a blank cell, type the formula =max(RANGE)-min(RANGE)
where RANGE is the range of the cells containing your data values.

• TI-30X IIS does not compute the max, min, or range

• Using TI-83 or TI-84

1. Follow the instructions for Entering a Data Set.

2. Enter the STAT menu, then arrow over to the CALC menu. Select the
first option: 1-Var Stats.

3. Enter the list containing your data values (using the LIST button). If you
also have a frequency list, enter a comma (the button above the number
7) and then enter the list containing your frequency list (using the LIST
button). Hit Enter.

4. Arrow down to the “minX” and “maxX” values. These are the minimum
and maximum values of your data set, respectively.
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7 Standard Deviation

• Using Excel

1. Follow the instructions for Entering a Data Set.

2. Excel 2007: In a blank cell, type the formula =stdev(RANGE) where
RANGE is the range of the cells containing your data values.

3. Excel 2010: In a blank cell, type the formula =stdev.s(RANGE) where
RANGE is the range of the cells containing your data values.

4. Note: If your data is in a frequency table, use the methods we discussed
in class.

• Using TI-30X IIS

1. Follow the instructions for Entering a Data Set.

2. Press the STATVAR button.

3. Arrow over to Sx. This displays the sample standard deviation of the data
set you entered.

• Using TI-83 or TI-84

1. Follow the instructions for Entering a Data Set.

2. Enter the STAT menu, then arrow over to the CALC menu. Select the
first option: 1-Var Stats.

3. Enter the list containing your data values (using the LIST button). If you
also have a frequency list, enter a comma (the button above the number
7) and then enter the list containing your frequency list (using the LIST
button). Hit Enter.

4. The fourth value Sx is the sample standard deviation of your data set.
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8 Quartiles Q1 and Q3

• Using Excel

1. Follow the instructions for Entering a Data Set.

2. In a blank cell, type the formula =quartile(RANGE,1) or =quartile(RANGE,3)
where RANGE is the range of the cells containing your data values. Use
the 1 for Q1 and the 3 for Q3.

3. Note: Excel computes quartiles slightly differently than we did in class,
so it may not be wise to use Excel to compute Q1 and Q3 for homework
problems.

• TI-30X IIS does not compute the quartiles.

• Using TI-83 or TI-84

1. Follow the instructions for Entering a Data Set.

2. Enter the STAT menu, then arrow over to the CALC menu. Select the
first option: 1-Var Stats.

3. Enter the list containing your data values (using the LIST button). If you
also have a frequency list, enter a comma (the button above the number
7) and then enter the list containing your frequency list (using the LIST
button). Hit Enter.

4. Arrow down to the “Q1” and “Q3” values. These are Q1 and Q3 of your
data set.

9 Scatter Diagrams

• Using Excel

1. Follow the instructions for Entering a Data Set. Ideally, you will have
entered the two variables side-by-side (in two adjacent columns). It must
be that the first x value listed matches up with the first y value listed, etc.

2. Highlight the cells with the data in it (not including the column headings).
Under the “Insert” menu, in the “Charts” section, click the first option
under the “Scatter” button.

3. The scatterplot will appear, but it will likely need some formatting changes
to be readable. You should click the “Layout” menu under the “Chart
Tools” heading and add axis titles and a chart title. Change the axis
scales if needed, and/or resize the chart to make it readable.
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• TI-30X IIS does not generate scatter diagrams

• Using TI-83 or TI-84

1. Follow the instructions for Entering a Data Set. Enter your x values in
one list and your y values in another list. It must be that the first x value
listed matches up with the first Y value listed, etc.

2. Select the STAT PLOT menu (2nd+Y= in the top row of buttons under
the screen).

3. Select the plot you would like to use (it doesn’t matter which one). Then
in the menu that opens up, select ON, the first type of chart, select the
lists for x and y using the LIST button, and then select the mark you want
to use to identify the points. (I recommend using the first or second option
- the box or the plus. The third option - the dot - is usually too small to
see.)

4. Press the GRAPH button (in the top row of buttons under the screen).
Change the viewing window if needed to ensure all of your data is showing.
To do this, press the WINDOW button (in the top row, again) and enter
the Xmin, Xmax, Ymin, and Ymax values you want to have displayed on
the screen. Then hit the GRAPH button to view the plot again.

10 Correlation Coefficient r

• Using Excel

1. Follow the instructions for Entering a Data Set. Ideally, you will have
entered the two variables side-by-side (in two adjacent columns). It must
be that the first x value listed matches up with the first y value listed, etc.

2. In a blank cell, type the formula =correl(xRANGE,yRANGE) where xRANGE
is the range of the cells containing the values of the variable x and yRANGE
is the range of the cells containing the values of the variable y.

• Using TI-30X IIS

1. Follow the instructions for Entering a Data Set with the 2-VAR option.

2. Press the STATVAR button.

3. Arrow over to r (on the fourth screen). This displays the correlation coef-
ficient of the data you entered.
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• Using TI-83 or TI-84

1. Follow the instructions for Entering a Data Set. Enter your x values in
one list and your y values in another list. It must be that the first x value
listed matches up with the first Y value listed, etc.

2. Enter the STAT menu, then arrow over to the CALC menu. Select the
fourth option: LinReg(ax+b).

3. Enter the list containing your x values (using the LIST button), then
enter a comma (the button above the number 7), and then enter the list
containing your y values (using the LIST button). Hit Enter.

4. The last value, labelled r, is the correlation coefficient of the data you
entered.

11 Equation of the Regression Line

• Using Excel

1. First follow the instructions for creating a scatterplot for your data.

2. Then click on the scatter diagram. In the “Layout” menu under “Chart
Tools” press the “Trendline” button and select “More Trendline Options.”

3. Make sure the “Linear” option is chosen in the popup box that comes up
(this is the default) and check the box at the bottom that says “Display
Equation on Chart.” Then press the Close button.

4. The graph and equation of the regression line will appear on the scatter-
plot. To format them (change the color, font, size, etc) just highlight what
you want to change and use the menus like you would for anything else.

• Using TI-30X IIS

1. Follow the instructions for Entering a Data Set with the 2-VAR option.

2. Press the STATVAR button.

3. Arrow over to a and b (on the fourth screen). The value for a is the slope of
the regression line (b1) and the value for b is the intercept of the regression
line (b0).

• Using TI-83 or TI-84

1. Follow the instructions for Entering a Data Set. Enter your x values in
one list and your y values in another list. It must be that the first x value
listed matches up with the first Y value listed, etc.
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2. Enter the STAT menu, then arrow over to the CALC menu. Select the
fourth option: LinReg(ax+b).

3. Enter the list containing your x values (using the LIST button), then
enter a comma (the button above the number 7), and then enter the list
containing your y values (using the LIST button). Hit Enter.

4. Arrow down to a and b (near the bottom of the list). The value for a is
the slope of the regression line (b1) and the value for b is the intercept of
the regression line (b0).

12 Factorial

• Using Excel

1. To get n!, type the formula =FACT(n).

• Using TI-30X IIS

1. To get n!, type in n first. Then press the PRB menu button (near the top
left corner), arrow over to the third option (which looks like an exclamation
point). Press Enter. Then on the screen you will see n!. Press Enter again
to see the answer.

• Using TI-83 or TI-84

1. To get n!, type in n first. Then press the MATH menu button, arrow over
to the last option PRB, then down to the fourth option, which looks like
an exclamation point. Press Enter. Then on the screen you will see n!.
Press Enter again to see the answer.

13 r-Permutations

• Using Excel

1. To get nPr, type the formula =PERMUT(n,r).

• Using TI-30X IIS

1. To get nPr, type in n first. Then press the PRB menu button (near the
top left corner), choose the first option (nPr). Press Enter. Then on the
screen you will see n nPr. Type in r. Press Enter again to see the answer.
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• Using TI-83 or TI-84

1. To get nPr, type in n first. Then press the MATH menu button, arrow
over to the last option PRB, then down to the second option, nPr. Press
Enter. Then on the screen you will see n nPr. Type in r. Press Enter
again to see the answer.

14 r-Combinations

• Using Excel

1. To get nCr, type the formula =COMBIN(n,r).

• Using TI-30X IIS

1. To get nCr, type in n first. Then press the PRB menu button (near the
top left corner), arrow over to the second option (nCr). Press Enter. Then
on the screen you will see n nCr. Type in r. Press Enter again to see the
answer.

• Using TI-83 or TI-84

1. To get nCr, type in n first. Then press the MATH menu button, arrow
over to the last option PRB, then down to the third option, nCr. Press
Enter. Then on the screen you will see n nCr. Type in r. Press Enter
again to see the answer.

15 Binomial Probability Distribution

• Using Excel

1. To find the probability of exactly x successes in n trials, use the formula
=BINOMDIST(x,n,p,FALSE)

2. To find the probability of less than x successes in n trials (cumulative
distribution), use the formula =BINOMDIST(x,n,p,TRUE)

• TI-30X IIS does not compute probability distributions
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• Using TI-83 or TI-84

1. To find the probability of exactly x successes in n trials, enter the DISTR
menu (2ND+VARS). Select the 11th option: binompdf. Enter n, then a
comma (the button is above the 7 key), then p, then another comma, then
x. Press enter.

2. To find the probability of less than x successes in n trials (cumulative dis-
tribution), enter the DISTR menu (2ND+VARS). Select the 12th option:
binomcdf. Enter n, then a comma (the button is above the 7 key), then p,
then another comma, then x. Press enter.

16 The Normal Probability Distribution

16.1 TI-83 or TI-84 (plus)

First turn on your calculator and press 2nd then VARS. This takes you to the DISTR
menu.

• To compute the area above/below/between given value(s) for the normal curve
with mean µ and standard deviation σ, select the second option, normalcdf
then enter the following parameters:

– For the percentage between values a and b (with a < b), enter the pa-
rameters in this order: a, b, µ, σ. (Note: Your calculator may give these
parameters names: lower, upper, µ, σ.)

– For the percentage above (to the right of) a value a, enter the parameters
in this order: a, 10 ∧ 99, µ, σ.

– For the percentage below (to the left of) a value b, enter the parameters
in this order: −10 ∧ 99, b, µ, σ. (Note: The - sign you need to enter for
−10 ∧ 99 is the button next to the period on the bottom row of buttons,
not the - sign you use for subtraction on the left side near the addition
and multiplication buttons.)

– Important Note: a and b need to be in terms of the data values, not
z-scores. If you want to enter the z-scores, use µ = 0 and σ = 1, not the
average and standard deviation for your data.

• To find the z-score with the pth percentile, select the third option from the
DISTR menu, invNorm, then enter the p value and leave the default values
µ = 0 and σ = 1.
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• To find the data value (not the z-score but the actual value) with the pth
percentile, select the third option from the DISTR menu, invNorm, then enter
the p value, and change the default values to the µ and σ for the distribution
you’re using.

16.2 Microsoft Excel

• For the percentage below (to the left of) a value x with mean µ and standard
deviation σ, use the following formula in Excel:
=NORMDIST(x, µ, σ, TRUE)

• To find the value associated with a given percentile p with mean µ and standard
deviation σ, use the following formula in Excel:
=NORMINV(p, µ, σ)

– Important Note: Enter your percentile p as a decimal, not as a percent-
age. For example, if you want to know for what value 45% of the data lies
below it, enter =NORMINV(0.45,µ,σ)

• Note: The above formulas will work for the data values. If you wish to input
z-scores instead, use µ = 0 and σ = 1.
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16.3 Using the z Table

The classical way to compute percentiles for z-scores and z-scores for percentiles is to
look it up in a pre-calculated table. This table appears on the next two pages. The
first table corresponds to negative z-scores; the second table corresponds to positive
z-scores. For the negative z-score table, the z-scores appear down the right side of the
table (with an additional digit of accuracy given across the top), and the percentage
of the data that lies below that z-score is the value given in the middle of the table.
The positive z-score table works in the same way, but with the z-scores down the left
hand side of the table rather than the right hand side.

For example, a z-score of -1.63 lies above 5.16% of the data, and a z-score of 2.76
lies above 99.71% of the data. Look at the tables and be sure you understand how to
read the table to get these values.

If you need to know what z-score corresponds to the 80th percentile of data, find the
value closest to 80% (0.8000) in the middle of the tables, then read the z-score from
the side and top. In this example, the values 0.7995 and 0.8023 appear in the table.
Since 0.7995 is closer to 80% than 0.8023, we will use that z-score, which is 0.84.
(0.7995 is in the 0.8 row and the 0.04 column)

Note: For z-scores less than -3.9, the percentile is estimated at 0.00% to two decimal
places (but it is not exactly equal to 0%). For z-scores greater than 3.9, the percentile
is estimated at 100.00% to two decimal places (but is not exactly equal to 100%).
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0.09 0.08 0.07 0.06 0.05 0.04 0.03 0.02 0.01 0.00 z

0.0000 - 3.9
0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 - 3.8
0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 - 3.7
0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 0.0001 0.0002 0.0002 - 3.6
0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 0.0002 - 3.5
0.0002 0.0003 0.0003 0.0003 0.0003 0.0003 0.0003 0.0003 0.0003 0.0003 - 3.4
0.0003 0.0004 0.0004 0.0004 0.0004 0.0004 0.0004 0.0005 0.0005 0.0005 - 3.3
0.0005 0.0005 0.0005 0.0006 0.0006 0.0006 0.0006 0.0006 0.0007 0.0007 - 3.2
0.0007 0.0007 0.0008 0.0008 0.0008 0.0008 0.0009 0.0009 0.0009 0.0010 - 3.1
0.0010 0.0010 0.0011 0.0011 0.0011 0.0012 0.0012 0.0013 0.0013 0.0013 - 3.0
0.0014 0.0014 0.0015 0.0015 0.0016 0.0016 0.0017 0.0018 0.0018 0.0019 - 2.9
0.0019 0.0020 0.0021 0.0021 0.0022 0.0023 0.0023 0.0024 0.0025 0.0026 - 2.8
0.0026 0.0027 0.0028 0.0029 0.0030 0.0031 0.0032 0.0033 0.0034 0.0035 - 2.7
0.0036 0.0037 0.0038 0.0039 0.0040 0.0041 0.0043 0.0044 0.0045 0.0047 - 2.6
0.0048 0.0049 0.0051 0.0052 0.0054 0.0055 0.0057 0.0059 0.0060 0.0062 - 2.5
0.0064 0.0066 0.0068 0.0069 0.0071 0.0073 0.0075 0.0078 0.0080 0.0082 - 2.4
0.0084 0.0087 0.0089 0.0091 0.0094 0.0096 0.0099 0.0102 0.0104 0.0107 - 2.3
0.0110 0.0113 0.0116 0.0119 0.0122 0.0125 0.0129 0.0132 0.0136 0.0139 - 2.2
0.0143 0.0146 0.0150 0.0154 0.0158 0.0162 0.0166 0.0170 0.0174 0.0179 - 2.1
0.0183 0.0188 0.0192 0.0197 0.0202 0.0207 0.0212 0.0217 0.0222 0.0228 - 2.0
0.0233 0.0239 0.0244 0.0250 0.0256 0.0262 0.0268 0.0274 0.0281 0.0287 - 1.9
0.0294 0.0301 0.0307 0.0314 0.0322 0.0329 0.0336 0.0344 0.0351 0.0359 - 1.8
0.0367 0.0375 0.0384 0.0392 0.0401 0.0409 0.0418 0.0427 0.0436 0.0446 - 1.7
0.0455 0.0465 0.0475 0.0485 0.0495 0.0505 0.0516 0.0526 0.0537 0.0548 - 1.6
0.0559 0.0571 0.0582 0.0594 0.0606 0.0618 0.0630 0.0643 0.0655 0.0668 - 1.5
0.0681 0.0694 0.0708 0.0721 0.0735 0.0749 0.0764 0.0778 0.0793 0.0808 - 1.4
0.0823 0.0838 0.0853 0.0869 0.0885 0.0901 0.0918 0.0934 0.0951 0.0968 - 1.3
0.0985 0.1003 0.1020 0.1038 0.1056 0.1075 0.1093 0.1112 0.1131 0.1151 - 1.2
0.1170 0.1190 0.1210 0.1230 0.1251 0.1271 0.1292 0.1314 0.1335 0.1357 - 1.1
0.1379 0.1401 0.1423 0.1446 0.1469 0.1492 0.1515 0.1539 0.1562 0.1587 - 1.0
0.1611 0.1635 0.1660 0.1685 0.1711 0.1736 0.1762 0.1788 0.1814 0.1841 - 0.9
0.1867 0.1894 0.1922 0.1949 0.1977 0.2005 0.2033 0.2061 0.2090 0.2119 - 0.8
0.2148 0.2177 0.2206 0.2236 0.2266 0.2296 0.2327 0.2358 0.2389 0.2420 - 0.7
0.2451 0.2483 0.2514 0.2546 0.2578 0.2611 0.2643 0.2676 0.2709 0.2743 - 0.6
0.2776 0.2810 0.2843 0.2877 0.2912 0.2946 0.2981 0.3015 0.3050 0.3085 - 0.5
0.3121 0.3156 0.3192 0.3228 0.3264 0.3300 0.3336 0.3372 0.3409 0.3446 - 0.4
0.3483 0.3520 0.3557 0.3594 0.3632 0.3669 0.3707 0.3745 0.3783 0.3821 - 0.3
0.3859 0.3897 0.3936 0.3974 0.4013 0.4052 0.4090 0.4129 0.4168 0.4207 - 0.2
0.4247 0.4286 0.4325 0.4364 0.4404 0.4443 0.4483 0.4522 0.4562 0.4602 - 0.1
0.4641 0.4681 0.4721 0.4761 0.4801 0.4840 0.4880 0.4920 0.4960 0.5000 - 0.0
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z 0.00 0.01 0.02 0.03 0.04 0.05 0.06 0.07 0.08 0.09

0.0 0.5000 0.5040 0.5080 0.5120 0.5160 0.5199 0.5239 0.5279 0.5319 0.5359
0.1 0.5398 0.5438 0.5478 0.5517 0.5557 0.5596 0.5636 0.5675 0.5714 0.5753
0.2 0.5793 0.5832 0.5871 0.5910 0.5948 0.5987 0.6026 0.6064 0.6103 0.6141
0.3 0.6179 0.6217 0.6255 0.6293 0.6331 0.6368 0.6406 0.6443 0.6480 0.6517
0.4 0.6554 0.6591 0.6628 0.6664 0.6700 0.6736 0.6772 0.6808 0.6844 0.6879
0.5 0.6915 0.6950 0.6985 0.7019 0.7054 0.7088 0.7123 0.7157 0.7190 0.7224
0.6 0.7257 0.7291 0.7324 0.7357 0.7389 0.7422 0.7454 0.7486 0.7517 0.7549
0.7 0.7580 0.7611 0.7642 0.7673 0.7704 0.7734 0.7764 0.7794 0.7823 0.7852
0.8 0.7881 0.7910 0.7939 0.7967 0.7995 0.8023 0.8051 0.8078 0.8106 0.8133
0.9 0.8159 0.8186 0.8212 0.8238 0.8264 0.8289 0.8315 0.8340 0.8365 0.8389
1.0 0.8413 0.8438 0.8461 0.8485 0.8508 0.8531 0.8554 0.8577 0.8599 0.8621
1.1 0.8643 0.8665 0.8686 0.8708 0.8729 0.8749 0.8770 0.8790 0.8810 0.8830
1.2 0.8849 0.8869 0.8888 0.8907 0.8925 0.8944 0.8962 0.8980 0.8997 0.9015
1.3 0.9032 0.9049 0.9066 0.9082 0.9099 0.9115 0.9131 0.9147 0.9162 0.9177
1.4 0.9192 0.9207 0.9222 0.9236 0.9251 0.9265 0.9279 0.9292 0.9306 0.9319
1.5 0.9332 0.9345 0.9357 0.9370 0.9382 0.9394 0.9406 0.9418 0.9429 0.9441
1.6 0.9452 0.9463 0.9474 0.9484 0.9495 0.9505 0.9515 0.9525 0.9535 0.9545
1.7 0.9554 0.9564 0.9573 0.9582 0.9591 0.9599 0.9608 0.9616 0.9625 0.9633
1.8 0.9641 0.9649 0.9656 0.9664 0.9671 0.9678 0.9686 0.9693 0.9699 0.9706
1.9 0.9713 0.9719 0.9726 0.9732 0.9738 0.9744 0.9750 0.9756 0.9761 0.9767
2.0 0.9772 0.9778 0.9783 0.9788 0.9793 0.9798 0.9803 0.9808 0.9812 0.9817
2.1 0.9821 0.9826 0.9830 0.9834 0.9838 0.9842 0.9846 0.9850 0.9854 0.9857
2.2 0.9861 0.9864 0.9868 0.9871 0.9875 0.9878 0.9881 0.9884 0.9887 0.9890
2.3 0.9893 0.9896 0.9898 0.9901 0.9904 0.9906 0.9909 0.9911 0.9913 0.9916
2.4 0.9918 0.9920 0.9922 0.9925 0.9927 0.9929 0.9931 0.9932 0.9934 0.9936
2.5 0.9938 0.9940 0.9941 0.9943 0.9945 0.9946 0.9948 0.9949 0.9951 0.9952
2.6 0.9953 0.9955 0.9956 0.9957 0.9959 0.9960 0.9961 0.9962 0.9963 0.9964
2.7 0.9965 0.9966 0.9967 0.9968 0.9969 0.9970 0.9971 0.9972 0.9973 0.9974
2.8 0.9974 0.9975 0.9976 0.9977 0.9977 0.9978 0.9979 0.9979 0.9980 0.9981
2.9 0.9981 0.9982 0.9982 0.9983 0.9984 0.9984 0.9985 0.9985 0.9986 0.9986
3.0 0.9987 0.9987 0.9987 0.9988 0.9988 0.9989 0.9989 0.9989 0.9990 0.9990
3.1 0.9990 0.9991 0.9991 0.9991 0.9992 0.9992 0.9992 0.9992 0.9993 0.9993
3.2 0.9993 0.9993 0.9994 0.9994 0.9994 0.9994 0.9994 0.9995 0.9995 0.9995
3.3 0.9995 0.9995 0.9995 0.9996 0.9996 0.9996 0.9996 0.9996 0.9996 0.9997
3.4 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9997 0.9998
3.5 0.9998 0.9998 0.9998 0.9998 0.9998 0.9998 0.9998 0.9998 0.9998 0.9998
3.6 0.9998 0.9998 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999
3.7 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999
3.8 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999 0.9999
3.9 1.0000
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